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TR-102

1. Introduction B

TR-102 is a personal remote positioning device with built-in GPS and GSM modules; it's compact and portable. Not only can
TR-102 transmit the longitude and latitude coordinate to your cell phone by the short message service, but it can also transmit
the longitude and latitude coordinate to your personal computer by the internet connection of GPRS and then displaying the
location by a specific map software. There are three speed-dial keys and one emergency key on the TR-102. You can use
these features for protecting and searching children and old persons. Further, you can use it as a security purpose and other
purpose which needs remote positioning.

2. Features _

1. GPS/GPRS personal locator.

2. GSM/SMS/GPRS communication.

3. Omni-directional high sensitivity GPS antenna which can receive GPS signal from all direction.

4. New technology and latest GPS SiRF-Star IlI chipset! Excellent for fixing the position even at a weak signal status.

5. Remote command control via mobile phones or through online software.

6. Receive phone calls to have two way communications.

7. Monitors can track the person without interfering him, LIVE! Real-Time tracking!

8. Locate the locator holder by just pressing a button on PC software or through mobile phone via SMS (short messaging
system).

9. Three quick dialing buttons for 3 preset phone numbers.

10. Works worldwide! Support 4-frequency GSM 850/900/1800/1900 MHZ and GPRS class 12.

11. SOS button send out exact location for immediate rescue/action.

12. Independent SOS (emergency) button which will send GPS location information via SMS for up to 3 preset numbers (it
can be 3 sets of different numbers than the 3 sets of quick dialing numbers).

13. Device can be connecting to PC by using a USB cable for setup the arguments (package comes with mini USB cable
when you purchase the device).

14. Report device holder’s position at a preset time interval.

15. Low battery notification before the battery dies out! Worrying free on why the locator wouldn’t respond for this kind of
situation!
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Software Feature

Professional Call Center program, supporting the operating system such as Windows 98 /2000 /XP, also supporting up to 5
sets of TR-102's tracking function at the same time by using the GPRS mode. Clicking on one of the TR-102's user name from
the Call Center program will open a browser with the latitude and longitude information displaying as a point at the center of
the maps.google.com. The display map is Google's patented right.

3. Specification B

Hardware
GSM module: embedded GSM 850/900/1800/1900 MHz , GPRS class 12
GPS Chipset: SiRF Star Il
Frequency: L1, 1575.42 MHz
C/A code: 1.023 MHz chip rate
Channels: 20 channel all-in-view tracking
Antenna Type: Omni-directional GPS antenna
Position Accuracy: 10 meters, 2D RMS
Velocity Accuracy: 0.1m/s
Time Accuracy: 1 us synchronized to GPS time
Default datum: WGS-84
Reacquisition: 0.1 sec., average
Hot start: 1 sec., average
Warm start: 38 sec., average
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Cold start: 42 sec., average

Altitude Limit: 18,000 meters (60,000 feet) max.
Velocity Limit: 515 meters/second (1000 knots) max.
Acceleration Limit: Less than 4g

Jerk Limit: 20 m/sec3

Operating temperature: -20°t0 55° C

Humidity: 5% to 95% Non-condensing

Dimension: 115 mm x 45 mm x 22.5 mm

\oltage: Rechargeable and replaceable 1300 mAh battery (3.7V), 5V for charging input.

Charging connector: DC 5V

Standby time: Over 100 hours

Talking time: 5~ 6 hours

LED: 3 LEDs showing Power, GPS and GSM status.

Key: 7 Keys for Power On/Off key, Emergency key, Intimate call * 3, Lock key and Answer/
Reject key.

USB port: Mini USB port for connecting to PC.

SAR: GSMB850 Head: 0.758

PCS1900 Head: 0.735
GSM850 Body(GSM): 0.206
PCS1900 Body(GSM): 0.177
GSM850 Body(GPRS): 0.21
PCS1900 Body(GPRS): 0.223
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4. Start-up o

4.1 Accessoriesil]

1. TR-102

2. 1300 mAh Li-ion Battery
3. Mini USB cable

4. AC power adapter

5. CD-ROM

6. Leather case (Optional)
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4.2 Charging the battery B

Before you can use the TR-102, you must complete the following procedures:

1. Fully charge the battery. Before your first time using of TR-102, please connect it with AC power adapter for battery charging at least
10 hours under the power-off condition. (The included battery is specially designed for TR-102. Please do not use other type of battery,
otherwise it will damage the device. If you need to change the battery for TR-102, please contact you local dealer.)

2. Install the SIM card. Please see the steps below in this page.

3. Complete the software setup. Please refer to chapter 6 for details.

4.3 Install SIM card

Install SIM card:

1. Press on the battery cover, then pull it downward to open it.
2. Remove the battery.
3. Insert the SIM card into the cartridge according to the direction shown, and close the cartridge when done.

4. Put back the battery, and close the battery cover.
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\5. Hardware Overview _

5.1 Appearance i

SOS button
- Speaker

h @F_{/ Answer / Hang up

Quick dial 1/ Volume up

Power button

Quick dial 2 / Mute the microphone

GSM LED £
GPSLED P Quick dial 3 / Volume down
Power LED Do
PG sat
Kj, Microphone
| —Button Lock Power adapter jack

Mini USB connector
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5.2 Button description _

Power button Turn on / Turn off: Please see 7.1 for details.

SOS button You can assign up to 3 sets of phone numbers to the SOS button. When this button is pressed, TR-102 will send
it's location information to these 3 sets of phone numbers by SMS.

TR-102 will first call the SOS number 1 and send the location information by SMS. Following, TR-102 will repeat
the same procedure to SOS number 2 and 3.

Answer / Hang up When there is a incoming call, press this button to answer the incoming call. While in talking, press it will hang up
the phone.

Quick dial 1/ Volume up | You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number.
While in talking, you can press this button to increase the volume.

Quick dial 2 / Mute the You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number.
microphone While in talking, the other party will not hear from you if this button is pressed to mute the microphone; press it
again to enable the microphone.

Quick dial 3 / Volume You can set a phone number for this button; when this button is pressed, TR-102 will dial the preset number.
down While in talking, you can press this button to decrease the volume.
GSM LED LED is on: TR-102 is turned on, but not connected to GSM network yet.

Blinking quickly (once per second): TR-102 is in dialing or talking mode.
Blinking slowly (once per 3 seconds): TR-102 is in the standby mode.

GPSLED The LED will be blinking when TR-102 is fixing its location. More details please see Page 21 for SOS button and
Page 27 for GPRS mode.

Power LED The LED will be orange when AC adapter is plugged for charging the battery. If the battery power is low, this LED
will be on in red.

Power adapter jack Plug in the Power adapter to TR-102's power adapter jack for battery charging.

Mini USB connector Connecting TR-102 to PC by a Mini USB cable, you can setup all its features and functions from an application
software in PC.

Button Lock Switch to lock all the buttons for the purpose of preventing buttons from been accidentally touched. (Only the
power button is not lockable. When Button Lock is on, the LED indicators will flash 3 times if any other button is
pressed.)

10



\6. TR-102 Setup and Call Center Operation

6.1 Install the USB driver -

1. Insert the CD into CD-ROM drive. When the autorun dialog box is displayed,
click on "Install USB Driver" button to install the TR-102 driver.
2. You will see dialog box 1, click on Next to continue.

3. When installation is complete, click on Finish to close the dialog box 2.
4. Reboot your PC to activate the USB driver.

PERSONAL TRACKER
TR~-102

Autorun Dialog box

InstallShield Wizard

Welcome to the InstallShield Wizard for PL-2303
USB-to-Serial

The InstaliShield® Wizard wil install PL-2303 USB-o-Seria
on your computer. To confinue. click Nex

Dialog box 1

InstaliShield Wizard

InstaliShield Wizard Complete

InstaliShield alieady successhully to installed PL-230%
-to-Serial diiver. Please press [Finish] button to close and
out of InstallShield

1f you have been plugged cable on P before run this setup,
please unplug and then plug cable again for system detect this

e [ -

Dialog box 2
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6.2 Install the Call Center program

1. From the autorun dialog box, click on the "Install PC Software" to install the
Call Center program.

2. Follow instruction of dialog box 1 to continue the installation.

3. When the installation is complete, click on Finish in dialog box 2 to close

the dialog box.

PERSONAL TRACKER

Autorun Dialog box

12

InstallShield Wizard

!I

Choose Destination Location
Select folder where Setup wil install files,

I

Setup wilinstall TR102-Call Center in the following folder,

Tainstall to this folder, click Nest. To install to 5 different folder, click Browse and select
ancther folder,

Destination Foider

C:\Program Files\GlobalS ath TR102-Call Canter Browse.

<Back Cancel

Dialog box 1

InstaliShield Wizard

InstaliShield Wizard Complete

P
& Setup has finished instaling TR102-Call Center on your
computer.

Dialog box 2
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6.3 Call Center Operation _

Menu item Icon button | Description

File > Save File (KML) Save the records as the KML format. You can import the KML file to Google Earth,
and it will display the location route. This function only works under the "Search

Records" mode.

File > Exit Close the Call Center program.

View > GPRS Tracking Switch to GRPS Tracking mode. You can view the information of TR-102 which is
Q on line.

View > Show Map Check this item to show the location point in Google Map or Google Earth.

Switch to Search Records mode. You can inquire information of one user during
a specific time. When you double click on one of these items, it will show the
location point of this item on Google Map or Google Earth.

View > Search Records

Management > User Information Display the User Information. You can setup up to 5 users in the Call Center.

Management > User Edit For deleting a user. The Call Center can only hold 5 users’ information at most. If
you want to add a new user after you have already set 5 users, please delete a
existing one first.

Management > Setup u When a TR-102 is connected to your PC, you can do the basic setup to this TR-
102.
GPRS > Start Start the Call Center connection to Internet. You can send the commands to TR-

102 if the Call Center is connected online.

GPRS > Pause Pause the Call Center connection from Internet. While your Call Center is online,

you can not enter the setup mode unless you pause the connection first.

GPRS > Send Command to RT102 Send Command to TR-102

Map > Google Map Set to display the location point by "Google Map".
Map > Google Earth Set to display the location point by "Google Earth".
About Version information.

13
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6.4 Basic Setting

-

. Connect the USB cable to TR-102 and the PC's USB port after installing the driver.

Scan COM Port:

N

Turn on the power of TR-102:

Scanning COM3...[Open succeed]
(i) Please wait for a while until the startup process is finished.

(i) Press and hold the "Answer/Hang up" button about 5 seconds until you see the three LEDs

flashing slowly and simultaneously. Release the button and it will enter the setup mode.

3. Start the TR-102 Call Center program in your PC (or double click on the "TR102-Call Center icon Scanning COMA...
from desktop).
Figure 1
4. Click Management > Setup in menu item, then press on the Scan button to scan the COM port

TR102-Setup
which TR-102 is connected. (Figure 1) When the scan process is finished, click on OK and it will

automatically set the correct COM Port.

o

Press on the Setup button (Figure 2) to open the setup dialog box.

o

For detailed description of those setting, please refer to the following pages.

Figure 2

Note: If your SIM card has the PIN code protected, a X e . =

dialog box will pop up first to ask you to enter the PIN. Please enter the password of SIM PIN your STM PIN is comect. continue sst up.

(Be careful when you enter the PIN code. Normally, if you
T [ ok |

enter the wrong code for 3 times, the SIM card will be

locked. If you do not know the PIN code or it has been
locked, please consult with your SIM card provider. s | ] |

14
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Setup X
Information Phone Mode IPhune Return} Phone List} Parameterl I Parameterzl
Return Count : 3 =
Return Type : SMS -
Check Phone List: |Off =
Answer Mode : On =
Time Zone : On hd
ok i| ResetDefault | Cancel ‘
item option | description
Return Type | GPRS | TR-102 will return the location information by GPRS.
SMs TR-102 will return the location information by SMS.
Answer Mode | Off TR-102 will not ring and user can not answer the call.
When received a call or SMS, TR-102 will return the location information by the way of "Return
Type". (please see figure. 3 in page 32)
On When received a call, TR-102 will ring, and user can answer the call. (please see figure. 1 in
page 32)
When received a SMS, TR-102 will return the location information by the way of "Return Type".
(please see figure. 2 in page 32)
Return count | 1~10 Set the time period in minute for GPS fixing.
Ehfck Phone | Off TR-102 will return the location information for all the incoming call.
IS
On TR-102 will return the location information only if the number of incoming call is from the Check
Phone List.
Time Zone On The SMS returned by TR-102 will contain a local time.
Off The SMS returned by TR-102 will contain a Coordinated Universal Time, abbreviated UTC.

15
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Note:
The returned SMS from TR-102 to your mobile phone will be the following format: (example)
Position Report:
TR102
2005/01/02 11:20:30
24.9965,121.4877
GPS fixed
* The second line shows your User Name (default is "TR102").
+ The third line contains the date and time. (yyyy/mm/dd hh:mm:ss)
+ The fourth line contains the longitude and latitude. You can copy this value and input it to "Google Earth" or maps.google.
com to find this position on map.
« The fifth line indicates "GPS fixed" or "GPS not fixed". (If it is "GPS not fixed", then the information of third and fourth
lines will be the one from last time GPS fixed.)

tem | description

Infurmaliunl Phone Mode Phone Return WPhune Lis|| Parameterl I Par 2] -
ﬁOSb When SOS button is pressed, TR-
umber

50§ Numberl : Quick Diall : 1~3 102 will dial to these 3 numbers

and send the location information

S0S Number? : Quick Dial? : to them by SMS. (please see
figure. 4 in page 33)

508 Number3 Sk Quick Dial | Assign numbers to Quick Dial
13 button 1~3 respectively. (please
Reset Default ‘ Cancel | see figUI’e- §in page 33)

16



Infurmaliunl Phone Mudel Phone Return  Phone List IParamclcﬂ I Paramclerzl
Phone Numberl : [0936311623  Phone Numbers: |
Phone Number2 : ’7 Phone Number7 : ,7
Phone Number3 : ’7 Phone Number§ : ,7
Phone Numberd : ’7 Phone Number9 : ,7
Phone Numberb : ’7 Phone Numberl10: '7

TR-102

item

description

Phone Number These 3 numbers are same as

1~3

Quick Dial number, you can
not modify it from here.

Phone Number You can set number 4 ~ 10.

0K ReselDefaull‘ Cancel |

Information IF'hune Mndel Phone He|urn1 Phone Lisll Parameterl I Par 2]

Moudle IMEI : 355632000090333 Name : |John

Firmware Version : [TR-101 v.stand_1.08 by  Phone : |1234567

0K ReselDefaull‘ Cancel |

4~10

item description

IMEI International Mobile Equipment
|dentity

Firmware | Firmware version of TR-102

Version

Name Input a user name here. (Default is
TR102)

Phone Input the phone number of this

TR-102.




TR-102

Infurmaliunl Phone Mudel Phone Helurn} Phone List Parameterl IPm 2]

5000
GPRS user name : GPRS_dns1 :

GPRS Port : GPRS apn : [internet

item description
GPRS Port Default GPRS Port
GPRS user name is "5000". Please
consult your Call
GPRS user password Center system

administrator for

GPRS user password : GPRS_dns2 : ‘
0K Reset Default ‘

Infurmaliunl Phone Mudel Phone Helurn} Phone Lis|| Parameter] Par 2 I

GPRS Server Host Name :

0K Reset Default ‘ Cancel

18

GPRS apn
all other parameter

GPRS_dns1

- values.
GPRS_dns2

Cancel

item description
GPRS Server Host Set the GPRS server
Name host name.




7. Operating the device

‘7.1 Turn on / Turn off -

o Turn on: When the device is off, press the Power button for 3 seconds,

three LEDs will start to flash quickly from top to bottom. It will enter the
standby mode with blue LED flash slowly after the startup process is
finished. (During the startup process, it can not be turned off.) Whe the
device is on, GPS will start to locate its position with the green GPS LED
flashing. If location is fixed, the LED will be on for a few seconds and
then goes out. If the location is not fixed in 3 minutes, the GPS function
goes sleep mode for 30 minutes before its next trial. It is suggested that
you be a outer place where it can receive the better GPS signal when
you turn on the device.

o Turn off: When the device is on, press the Power button for 3 seconds,
three LEDs will start to flash slowly from bottom to top. When the LEDs
go out, it indicates that the device is turned off for sure.

7.2 Answer / Hand up the phone -

o When there is an incoming call, press this button to answer the
incoming call.
o While in talking, press it will hang up the phone.

19
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7.3 Adjust the volume -

o While in talking, you can press the "+" button to increase the volume.

o While in talking, the other party will not hear from you if the mute
button is pressed to mute the microphone; press it again to enable the
microphone.

o While in talking, you can press the "-" button to decrease the volume.

7.4 Making a phone call -

e |f you have already setup the Quick dial number, then you can press
the Quick dial button to make a call to the preset number.
If you want to press the button to make a quick dial , please press the
button for over 1 second and release.

20
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<‘ .t Quick dial 2

| Quick dial 3
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7.5 Send out emergency SMS -

e [fyou have already assigned 3 sets of phone numbers to the SOS
button, press this button on the TR-102 will send out it's location
information to these 3 sets of phone numbers by SMS.

To avoid accidentally touching of this button, when you want to send
out the emergency SMS, please make sure you press this button for
over 2 seconds and release.

o TR-102 will first call the SOS number 1 and send the location
information by SMS. Following, TR-102 will repeat the same
procedure to SOS number 2 and 3.

@ How does it work when you press the SOS button?

1. To confirm that you have pressed SOS button correctly, TR-102 will followed by long flash the red LED about 2 times.

2. TR-102 will start to position itself with green GPS LED flashing; when the GPS position is fixed, the LED will be on.

3. Then, TR-102 will turn off GPS and green LED goes out.

4. TR-102 begins to send SMS with blue LED flash once per second.

5. When it finished sending SMS, the blue LED comes back to standby mode with flash once per three seconds.

6. If the SMS has been sent out successfully, TR-102 will again long flash the red LED about 2 times.

7. If the GPS position can not be fixed for 3 minutes, it will send back the SMS with a "no fixed" message and the last fixed position.

21
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8. Tracking by SMS mode B
‘ 8.1 Setup SMS return type -

et 3] - Connect the USB cable to TR-102 and
Information Phone Mode WPhunE Helurnl Phone Lisl} Parameterl I Pﬂramelerﬂ the PC's USB pOI‘t
" "
RewnCount: 3 =] « Enter the setup mode. Select "SMS
Return Type: | [SMS - Return Type from "Phone Mode" tab.
heck Phone List: |Off =
Answer Mode : On i
Time Zone : On =
Reset Default ‘ Cancel ‘

‘ 8.2 Send SMS from a cell phone to T

» Send a short message to TR-102 to trigger it for sending back the location information. (The message
content can be anything, even a blank message.)

8.3 TR-102 sends SMS to cell phone -

* When TR-102 receives a short message, it will return the location information by SMS in the following
format.

Position Report:

TR102

2005/01/02 11:20:30

24.9965,121.4877

GPS fixed

22
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8.4 Displaying the location on map -

o Start the Google Earth software. (For more information about the Google Earth software, please refer to “TR-102

Supporting User Manual En_Free Google Earth Software.pdf” which you can find them in the CD-ROM under the
“Manual” folder.)

Input the latitude and

wfu—um.s,m e [T BT longitude that you

e.g. Hotels near JFK

= |
249965, 121.4877 = [ -z
SR | ||

[+] 24,9965, 121.4877

received from SMS and

click on search button.

The Google Earth will
display the location map
w [7]E sightseeing

Start your Goodle
Earth world tour

. =l . % i G 123 for you.
+ [ ] MyPlaces - ‘e - A Eiald 5 . L

[ e toging P Dy ©

I” & Rosds I” [P Borcers
»[¥] B2 terrain E e

National Geog

23
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e Or you can start the Internet Explorer and type "http:/maps.google.com"” to connect to Google Map website for displaying

the location map.

2 Google Local - 24.9965,121.4877 - Microsoft Internet Explorer

© Rl Edt View Favorites Tools  Help

@Eack - \) B @ (h psaavch *Favnrltes A eda £2) Bv

&ddresl ] hitgmaps. google.comt |

Froogle Local

more »

i
SEUEH
Y8
Help

H A ] Search the map

Google

Local

, san francisoo”

Find businesses

Get Directions

Select "Satellite" or "Hybrid". It

Local

24.996500, 121.487700
+24* 50° 47 40", +121°29'15.72"
hiake this my default location

Directions: To here - From here

Print < Email == Link to this page
————— depends on Google Map whether your

area is supported by this mode or not.

Input the latitude and longitude that
you received from SMS and click on
Search button.

The Google Map will display the

location map for you.

&] http://fraogle. google.comjfrongle?sa=Hat ab=F

 Internet

24
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9. Tracking by GPRS mode B

‘ 9.1 Setup GPRS return type -
) 53] . Connect the USB cable to TR-102 and the
Information Phone Mode IF‘hunE Relurnl Phone Lisl} Parameterl 1 F‘alameler?} PC's USB pOl’t
Return Count: |3 = * Enter the setup mode. Select "GPRS"
Return Type: | [GPRS -] Return Type from "Phone Mode" tab.
Check Phone List: |Oft =2
Answer Mode : On o
Time Zone : On =

OK | F\eSetDefauIt| Cancel ‘

9.2 Trigger the TR-102 to connect to Internet by GPR-

« If the Answer Mode is "Off", you can use the cell phone to call TR-102, or send a short message to TR-
102 to trigger it for connecting to internet.

« If the Answer Mode is "On", you can only send a short message to TR-102 to trigger it for connecting
to internet.

25
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9.3 Send a command from Call Center to TR-102 -

* You can send command to TR-102 by the following steps and make it send back the location
information:
(1) Start the TR-102 Call Center program and click on "GPRS" > "Start" from menu bar to start the
connection for internet.
(2) Click on "GPRS" > "Send Message" to display the Send Message box.
(3) Select the Name, Return Mode, and Second if necessary. Click on OK button to send out this
command.

(4) Please refer to the below description for how to 3end Command X
select the "Return Mode" and "Return Time". | 5
Name : -
Return Mode : |Irnm|:diale Report j

Return Time : Second

0K Cancel ‘

26
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Return Return description
Mode Time
(second)
Immediate N/A When TR-102 receives this command, it will send the report back immediately. It will
report send only one time, and the GPRS connection is still on.

While TR-102 is in the "immediate report" mode, blue LED will flash once per second;
and it begins to start GPS function with green LED flashing. When position is fixed,
green LED will be on until it gets the next report request.

Period report | 5~ 86400 | When TR-102 receives this command, it will send back the report every specified
seconds second. And the GPRS connection is still on.

When the specified period of time is reached, TR102 will start GPS function with green
LED flashing. When position is fixed, LED will be on until the time period is reached
again; it will repeat the same procedure.

The time error of return could be 1~3 seconds, or larger if the GPRS connection is not

stable.
Stop connect | N/A When TR-102 receives this command, it will disconnect from GRPS and go to sleep
mode.
Stop connect | 30 ~ 86400 | When TR-102 receives this command, it will send the report back immediately by
and set seconds starting the GPS function with green LED flashing. When position is fixed, green LED
period report is on and the GPRS connection is set for the data transferring with blue LED flash

once per second. After that, it will disconnect from GRPS and go to sleep mode with
green LED goes out and blue LED comes back to standby mode. When the specified
period of time is reached, it will wake up and connect to internet via GPRS to send
the report, and go to sleep mode again. It will repeat the same procedure when the
specified period time is reached again.

Due to the GPS function is closed most of time, when it starts the GPS function, it
could take a little bit longer to get a fixed position. If the GPS signal is not strong
enough, it could take more 3 minutes (also depending on the stability of GPRS
connection.)

@ For detailed description of how to set the Return Mode and Second, please see "TR-102 GPRS Access command Vx.x.pdf" in the
CD-ROM under the "Manual" folder.

27
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‘ 9.4 TR-102 sends back location information to Call Cen

* When TR-102 receives a command, it will send back the location information by GPRS. Please switch
to GPRS view in the Call Center program and you can see the most updated information is displayed
in the top of the list.

TR102-Call Center_¥1.09 —1®(x|

File View Msnagement GPRS Map About

P Name : [NONO User Information

™ Name?: NONG Latitude :  [24.998152 GPS Date-Time :

™ Name3 : Longitude : [121.487087 2002/02/04-17:36:33

0930192222

™ Named: GPS Altitude ; [00161 Receive Date-Time :

™ Name5 : Imei:  |355632000162645  GPs Status: [No Fix [2006703728-12:31:04
NONO 0930192222 2006003720 14:31.04 24998152 121 487087 20020204 17:36:33 Mo Fix 00161
NONO 0930192222 200603728 20:16:57 24996500 121 487353 2006102716 16:13:37 3D 636
NONO 0930192222 200603728 18:35:58 24996500 121 487353 200602716 16:13:37 3D 636
NONO 0930192222 200602728 18:35:23 24096000 121 487353 20060216 16:13:37 2D 626
NONO 0930192222 200603128 17:56:23 24996000 121 487353 20060216 16:13:37 2D 636
NoNo 0930192222 200603728 17:55:37 24996500 121487353 2006102716 16:13:37 2D 626
NONO 0930192222 200603128 17:53:30 24996500 121 487353 200602716 16:13:37 3D 636
NONO 0930192222 200603728 17:52:58 24096000 121 487353 2006102716 16:13:37 D 626
NONO 0930192222 200602128 17:51:23 24096000 121 487353 20060216 16:12:37 g 626
HOXO oiszzz  200amsmE 175034 24996500 121487353 00602116 161337 E 635
NONO 0930192222 200603728 17:5000 24996500 121 487353 2006102716 16:13:37 3D 636
NONO 0930192222 200603728 174825 24996300 121 487353 200602716 16:13:37 3D 636
NONO 0930192222 200603728 17:4725 24096000 121 487353 2006102716 16:13:37 Eul 626
NONO 0930192222 200603128 17:3147 24996000 121 487353 20060216 16:13:37 2D 636
HOXO oisz;z  200amsEE 172330 24996500 121487353 006m2116 161337 E 635
NONO 0930192222 200603128 17:2038 24996500 121 487353 2006102716 16:13:37 3D 636
NONO 0930192222 200603728 17:18:50 24096900 121 487353 2006102716 16:13:37 D 626
NONO 0930192222 200602128 17:1806 24096000 121 487353 20060216 16:13:37 D 626
HOXO oisz;z  200amsEE 162652 2458152 121 487087 20020204 173633 Mo Fix o016
NoNo 0930192222 200603728 16:2625 24.995152 121 487087 2002102004 17:26:33 Mo Fix o01g1
NONO 0930192222 200603728 16:2248 24998152 121 487087 200200204 17:36:33 Mo Fix 00161
NONO 0930192222 200603728 16:15:45 24098152 121 487087 200200204 17:36:33 Mo Fix 00161
NONO 0930192222 200602128 16:1500 24098152 121 487087 20020204 17:36:33 Mo Fix 00161
nowO oisz;z  200amsEE 161444 24958152 121 487087 20020204 173633 Ho Fix o016
NOoNo 0930192222 200603728 16:1428 24998152 121 487087 2002102004 17:36:33 Mo Fix 00161
NONO 0930192222 200603728 16:13:31 24098152 121 487087 200200204 17:36:33 Mo Fix 00161
NONO 0930192222 200602128 142106 24008152 121 470420 20020204 17:36:33 Mo Fix 00161
NONO 0930192222 200603128 14:3012 24998152 121 470420 20020204 17:36:33 Mo Fix 00161
Nono 0930192222 200603728 142919 24.995152 121 487087 2002102004 17:26:33 Mo Fix o01gl
NONO 0930192222 200603728 142903 24998152 121 487087 200202004 17:36:33 Mo Fix 00161
NONO 0930192222 200603728 14:28:50 24098152 121 487087 200200204 17:36:33 Mo Fix 00161
i nonimms  omenaa e P 191 afrey 7% ¥ s s
q

[Reaty [ o |
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‘ 9.5 Displaying the location on map -

e Click on Map from menu bar, you can setup the
program to display the map by "Google Map" or

109 ala1x]
R "Google Earth’.
O € (]
{ T ‘ o |f you have checked the View > Show Map, the
i"J;, Call Center program will make the "Google Map" or

"Google Earth" to refresh the display when receiving
the updated information.

e Or you can double click on any item, it will also show
the location map on "Google Map" or "Google Earth".

srFEEEEEEErEsTasa
TERRRIIT R

v Google Map
Google Earth
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10. How does TR-102 work by SMS and GRPS? B

How exactly does TR-102 works (SMS)

e SMS send back

location
information to user

SMS reply
wit|

location
information

Carrier's

Fix satallite Server

position

SMS pending o

to TR-102
SMS requesting
for reply

Using meblie phone
TR-102 using SMS function to send SMS
reply location information
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How exactly does TR-102 works (GPRS)

Partnership with a service provider

GPRS send back location
information and display
on E-map automatically

GPRS reply with
location information
Carrier's

Server

Fix satallite
position

9 GPRS requesting

for reply
GPR Spending

to TR-102
Using service provider's
TR-102 using GPRSo function webside to request location
to reply locationinformation information
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Mobile Phone Call Answer

Figure. 1

SMS

(Any content, include blank SMS.)

Mobile Phone TR-102

SMS

3 example Position Report:
Figure. 2 TR102
2005/01/02 11:20:30
24.9965,121.4877
GPS fixed

Call or SMS

(Any content, include blank SMS.)

Mobile Phone

SMS

i example Position Report:
Figure. 3 TR102

2005/01/02 11:20:30
24.9965,121.4877
GPS fixed
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Mobile Phone
il
L SOS number 1 TR-102
D
il
j E‘E SOS number 2 SMS
— example Emergency Report: When SOS button
1| TR102 is pressed.
anl 2005/01/02 11:20:30
— @—|SOS number 3 24.9965,121.4877
SIets Figure. 4 GPS fixed
D
Mobile Phone TR-102
Quick Dial number
Call
Answer a
When Quick Dial
| button is pressed.
Figure. 5
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11. Troubleshooting

status

cause

solution

After you turn on the power of
TR-102, the three LEDs are
flashing simultaneously.

The SIM card is not
inserted.

Please insert the SIM card into TR-102.

The SIM card is
inserted in the TR-
102, but it has the
PIN code protection
enabled and the PIN
code is mismatched.

Please take out the SIM card, use your mobile
phone to disable the PIN code protection and then
insert the SIM card back to TR-102. Then you will
not be asked the PIN code in the Setup mode.

Or connect the TR-102 to PC and enter the setup
mode of Call Center program to input the correct
password.

After you turn on the power of
TR-102, the Blue GSM LED is on.

The signal is too
weak.

Please move to a location where there is a
stronger signal.

» For more information about the Google Earth software and Free DDNS Service, please refer to "TR-101
Supporting User Manual EN1_Free DDNS Service.pdf" and "TR-101 Supporting User Manual En_Free Google
Earth Software.pdf" which you can find them in the CD-ROM under the "Manual" folder.

» In general situation, it needs about 4 ~ 5 hours to fully charge the battery under the power-off condition.

If you

charge the battery under the power-on condition, it may need longer charging time depending on different usage

mode.

» There is a little tenon on the rubber cover of TR-102 USB port (please see the right figure). You
have to press it a little harder downward to close it firmly. There will be a click sound if you do

the right way.

» Please do not connect TR-102 to AC power adapter during its startup process, otherwise it can

not be turned on properly.

» Please do not connect TR-102 to a USB cable when you are changing the battery, otherwise it

will make some beep sound.

» If TR-102 can not be turned off properly, please open the battery cover and remove the battery for 3 seconds at
least. Put the battery back and then restart it.
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> When you press the KML button, only the
item with GPS fixed (2D or 3D) will be “’6\‘3,‘,' a (
exported. If all the items are "No Fix", —

. Start Date Time v

then it can not be exported to the KML 200 Satimel z567 PM = Choose name : [sunx |

file, and you will see the error message Stop DateTime. [ e |

StopData| 41412006 StopTime | 2:56:17PM =

with "No effective data". e e ] o s s | e

sunx. 0930192222 2006/04/14 2006/04/14 13:39:54 30
sunx. 0930192222 2006/04{14 24.996058 2006/04/14 13:39:30 30
sunx. 0930192222 2006/04{14 24.996593 2006/04/14 13:37:15 30
sunx 0930192222 2006/04{14 24.996540 2006/04/14 12:24:52 Mo Fix
sunx 0930192222 2006/04{14 24.996803 2006/04/14 12:23:52 30
sunx 0930192222 2006/04{14 24.996867 2006/04/14 12:23:31 30
sunx 0930192222 2006/04{14 24.996598 2006/04/14 12:23:18 30
sunx 0930192222 2006/04{14 24.996598 2006/04/14 12:22:36 Mo Fix
sunx: 0930192222 2006/04{14 24.987265 2006/04/14 12:22:15 Mo Fix.
sunx 0930192222 2006/04{14 24.987682 2006/04/14 12:21:55 30

Mo effective data sunc 0930192222 20060414 24996558 2006/0414 121610 Ed
sunx 0930192222 2006/04{14 24.996562 2006/04/14 12:12:53 30
sunx 0930192222 2006/04{14 24.996552 2006/04/14 12:12:33 30
sunx 0930192222 2006/04{14 24.996553 2006/04/14 12:12:28 30

sunx 0930192222 2006/04/14 24996550 2006/0414 12:11:56 D
i

£
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